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ККорпорация Analog Devices, Inc. (ADI) 
предлагает на рынке широкую номен-
клатуру так называемых аналоговых 

микроконтроллеров (МК), известных также 
специалистам как микроконверторы. Под 
аналоговым МК понимается устройство, со-
держащее на одном кристалле приоритетные 
аналого-цифровые узлы — высокоточные 
АЦП, ЦАП, а также цифровые узлы — про-
цессорное ядро, память, различную анало-
говую и цифровую периферию. Основное 
внимание производитель этих МК уделяет 
аналоговым измерениям, а ядро и вся циф-
ровая часть устройства, по сути, является 
«придатком» АЦП (она выполняет функции 
обслуживания — обработку данных, интер-
фейс с внешними устройствами, управление, 
корректировку измерений). Таким образом, 
цифровая часть образует необходимые ин-
терфейсы взаимодействия с пользователь-
ской средой.

Помимо собственно АЦП такое устрой-
ство может содержать на кристалле различ-
ные полезные его дополнения: инструмен-
тальные аналоговые усилители, буферы 
входных аналоговых сигналов, источники 
опорного напряжения, напряжения смеще-
ния и тока возбуждения внешних датчиков, 
аппаратные фильтры обработки, встроенные 
процедуры калибровок, средства поддерж-
ки цифрового усреднения результатов и т. п. 
Таким образом, по замыслу производителя, 
аналоговый МК заменяет сразу несколько 
микросхем, традиционно образующих систе-
му сбора данных (АЦП, МК, ИОН, микро-
схемы интерфейсов и питания, входные бу-
феры), за счет чего достигается значительная 
аппаратная экономия при сохранении точ-
ностных и скоростных характеристик такого 
измерителя.

Обзор семейств 
микроконтроллеров  
Analog Devices

В настоящее время все выпускаемые ADI 
аналоговые МК [1] относятся к трем семей-
ствам: с 8‑разрядным процессорным ядром 
8052 (ADuC8xx), с 32‑разрядным ядром 
ARM7TDMI (ADuC7xxx) и с  32‑разряд-
ным ядром ARM Cortex-M3 (ADuCM36x). 
Основные характеристики перечисленных 
семейств представлены в таблицах 1–3.

Сравнительный анализ всех перечислен-
ных в таблицах устройств позволяет сделать 
следующие выводы.

Устройства семейства ADuC8xx [2] 
(табл. 1) преимущественно имеют «медлен-
ный» высокоточный АЦП и значительное 
количество линий GPIO, достаточное для 
построения приложений большой сложно-
сти. Однако слабая по современным меркам 
производительность ядра, небольшой объем 
памяти и сравнительно «медленные» интер-

фейсы не позволяют использовать их в «бы-
стрых» приложениях и при решении задач, 
требующих существенных вычислительных 
ресурсов. Очевидно, что предпочтительная 
сфера применения этих МК — «медленные» 
прецизионные измерения.

Устройства семейства ADuC7xxx [3] 
с высокопроизводительным 32‑разрядным 
ядром (табл. 2), как правило, имеют «бы-
стрый», но не столь точный АЦП (кроме 
микроконтроллеров AduC706x, которые со-
держат 24‑разрядный АЦП. — Прим. ред.). 
Предпочтительная сфера применения этих 
МК — «быстрые» потоковые измерения, 
к прецизионности которых не предъявляется 
повышенных требований.

Н е д а в н о  п о я в и в ш е е с я  с е м е й с т в о 
ADuCM36x [4], судя по данным таблицы 3, 
имеет оптимальное сочетание возможно-
стей как периферии (прежде всего точность 
и скорость АЦП), так и ядра (разрядность 
и производительность). Таким образом, МК 
этой серии можно использовать в «быстрых» 

Статья содержит сведения об основных характеристиках и архитектуре, а так‑
же описание опыта практического использования недавно появившегося 
на рынке семейства 32‑разрядных прецизионных микроконверторов (ана‑
логовых микроконтроллеров) ADuCM36x с ядром ARM Cortex-M3 компании 
Analog Devices. Приведен перечень всех аналоговых МК общего назначения, 
выпускаемых производителем этого семейства, рассказано о существующих 
средствах поддержки разработки приложений на базе ADuCM36x, основных 
этапах такой разработки, а также описано реальное устройство на базе МК 
ADuCM360 — прецизионный измеритель напряжения.

Прецизионные 
микроконверторы ADuCM36x — 
быстрый старт

Таблица 1. Аналоговые микроконтроллеры семейства ADuC8xx

Устройство
Производи- 
тельность  

ЦПУ, MIPS

Размер  
Flash-памяти, 

кбайт

Размер 
SRAM,  

байт

Кол-во  
линий  
GPIO 

Разрешение 
АЦП,  
бит

Скорость  
преобразо‑

ваний  
АЦП, SPS

Кол-во  
каналов  

АЦП 
Прочее

Кол-во  
выходов 

12-разряд-
ного ЦАП

ADUC845 12 62 2,304K 34 24 1,37K 10 ШИМ 1

ADUC847 12 62 2,304K 34 24 1,37K 10 ШИМ 1

ADUC848 12 62 2,304K 34 16 1,37K 10 ШИМ 1

ADUC841 20 62 2,304K 34 12 400K 8 ШИМ 2

ADUC842 16 62 2,304K 34 12 400K 8 ШИМ 2

ADUC843 16 62 2,304K 34 12 400K 8 ШИМ –

ADUC831 1,3 62 2,304K 34 12 247K 8 ШИМ 2

ADUC832 1,3 62 2,304K 34 12 247K 8 ШИМ 2

ADUC834 1 62 2,304K 34 24 105 4 ШИМ 1

ADUC836 1 62 2,304K 34 16 105 4 ШИМ 1

ADUC814 1,3 8 256 17 12 247K 6 – 2

ADUC816 1,3 8 256 34 16 105 4 – 1

ADUC824 1 8 256 34 24 105 4 – 1

ADUC812 1,3 8 256 34 12 200K 8 – 2
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приложениях для высокоточных измерений. 
От МК ADuC7xxx устройства ADuCM36x 
выгодно отличаются существенно большей 
экономичностью.

Выбор ядра Cortex-M3 при разработке ми-
кросхемы производителем был обусловлен 
именно наилучшим соотношением произ-
водительности и энергопотребления. Однако 
скромный набор цифровой периферии 
и сравнительно небольшое количество ли-
ний GPIO все же ограничивает применение 
ADuCM36x приложениями малой и средней 
сложности.

Описание микроконтроллера 
ADuCM360

Структурная схема МК ADuCM360 пока-
зана на рис. 1. Главный узел устройства — 
прецизионный многоканальный 24‑разряд-
ный ∆Σ-АЦП (у ADuCM360 — сдвоенный, 
у ADuCM361 — одиночный), имеющий 
входной аналоговый мультиплексор, что 
позволяет коммутировать на входы АЦП 
любые из 11 линий внешних аналоговых 
входов, объединяя их в дифференциальные 
пары или оставляя асимметричными. В АЦП 
поддерживается режим автоматически про-
изводимой «переполюсовки» (chop) симме-
тричных входов в паре при преобразовани-
ях для компенсации внешнего смещения. 
Помимо внешних, у АЦП есть и несколько 
внутренних входов, позволяющих измерять 

напряжение питания МК, температуру (с вы-
хода встроенного датчика) и напряжение 
с выхода встроенного узла ЦАП.

В каждом АЦП имеется программируе-
мый усилитель входных аналоговых сиг-
налов, аналоговый буфер для улучшения 
входных характеристик измерителя и про-
граммируемые аппаратные фильтры на вы-
ходе ∆Σ-модуляторов, улучшающие помехо-
устойчивость измерений. Источник опорно-
го напряжения (ИОН) при преобразованиях 
можно использовать встроенный или под-
ключать к МК внешний (до двух внешних 
источников одновременно). Помимо этого, 
на кристалле находятся программируемые 
источники тока возбуждения внешних (пас-
сивных) датчиков, а также источник напря-
жения смещения. Эти источники можно 
программно подключать к внешним входам 
АЦП. Кроме АЦП, МК ADuCM36x содержат 
узел одноканального 12‑разрядного ЦАП 
по напряжению.

Столь внушительный перечень аналого-
вых функций обслуживается 32‑разрядным 
процессорным ядром ARM Cortex-M3 с мак-
симальной тактовой частотой 16  МГц 
(при удельной производительности ядра 
1,25 MIPS/МГц обеспечивается предельная 
производительность 20 MIPS), 12‑каналь-
ным контроллером DMA и векторизован-
ным контроллером прерываний. На ядро 
можно возлагать задачи по обработке ре-
зультатов преобразований (для чего в МК 

имеется аппаратная поддержка цифрового 
накопления/усреднения и нескольких типов 
калибровок), а также по организации взаи-
модействия с пользовательской средой через 
набор традиционных интерфейсов: UART, 
I2C, 2SPI, 19 линий GPIO, модуль 6‑каналь-
ного ШИМ и два таймера-счетчика общего 
назначения.

МК семейства ADuCM36x оптимизирова-
ны для устройств с батарейным питанием. 
Удельное энергопотребление ядра МК со-
ставляет 290 мкА/МГц, включая потребле-
ние встроенных Flash-памяти и SRAM. В ак-
тивном режиме на максимальной тактовой 
частоте 16 МГц с включенной периферией 
МК потребляет от единственного источни-
ка +3,3 В ток 5,5 мА, а на тактовой частоте 
500 кГц — 1 мА. В режиме Power-down ток 
потребления МК составляет около 4 мкА.

МК поставляются в 48‑выводном корпусе 
LFCSP, они работоспособны в диапазоне пи-
тающих напряжений от 1,8 до 3,6 В в темпе-
ратурном диапазоне от –40 до +125 °C.

Рекомендуемые производителем области 
применения ADuCM36x: приборы учета 
энергоресурсов (теплосчетчики, расходоме-
ры), автомобильная техника (контроль со-
стояния аккумуляторов), промышленность 
(интеллектуальные датчики и системы сбора 
данных, прецизионные измерители в систе-
мах контроля параметров), передача данных 
(оптические приемопередатчики).

Поддержка разработки приложений 
на базе ADuCM36x на момент написания 
этой статьи была представлена следующи-
ми аппаратными и программными сред-
ствами. В качестве основного аппаратного 
средства разработки/отладки предлагается 
сравнительно недорогой стартовый ком-
плект EVAL-ADUCM360QSPZ [5, 8] (рис. 2), 
включающий в себя универсальную оце-
ночную плату с МК ADuCM360 с распаян-
ными на контактные площадки выводами 
(EVAL-ADUCM360MKZ Board), плату-пере-
ходник для программирования/отладки при-
ложений на базе ADuCM36x (ADUCM360 
USB-SWD/UART-EMUZ), а также USB-JTAG 
программатор (SEGGER J‑Link Lite board). 
Программирование/отладка МК ADuCM360 
осуществляются через USB-JTAG програм-
матор из ПК хоста. Записанное в память 
МК на заводе ПО внутрисхемного загрузчи-
ка (kernel) поддерживает режимы внутри-
схемного программирования встроенной 
Flash-памяти по двухпроводному последо-
вательному интерфейсу SW и через UART 
МК, а также эмуляции по последовательному 
интерфейсу. В состав стартового комплекта 
входят программные библиотеки всех пери-
ферийных узлов и примеры демопроектов, 
использующих эти библиотеки.

Для того чтобы ускорить процесс разра-
ботки, ADI выпускает оценочные комплек-
ты, предназначенные для реализации кон-
кретных приборов. Вместо оценочной платы 
«общего назначения» EVAL-ADUCM360MKZ 

Таблица 2. Аналоговые микроконтроллеры семейства ADuC7xxx

Устройство

Производи- 
тельность  

ЦПУ,  
MIPS

Размер  
Flash- 

памяти,  
кбайт

Размер  
SRAM,  
кбайт

Кол-во  
линий  
GPIO 

Разре- 
шение  
АЦП,  
бит

Кол-во  
каналов  

АЦП 

Скорость  
преобра- 
зований  

АЦП, SPS

Прочее

Кол-во  
выходов  

12-разряд- 
ного ЦАП

ADUC7019 40 62 8,192 14 12 5 1M – 3

ADUC7020 40 62 8,192 14 12 5 1M – 4

ADUC7021 40 62 8,192 13 12 8 1M – 2

ADUC7022 40 62 8,192 13 12 10 1M – –

ADUC7023 40 62 8,192 20 12 12 1M ШИМ 4

ADUC7024 40 62 8,192 30 12 10 1M ШИМ 2

ADUC7025 40 62 8,192 30 12 12 1M ШИМ –

ADUC7026 40 62 8,192 40 12 12 1M ШИМ 4

ADUC7027 40 62 8,192 40 12 16 1M ШИМ –

ADUC7028 40 62 8,192 40 12 8 1M – 4

ADUC7029 40 62 8,152 22 12 7 1M – 4

ADUC7033 20 96 6,144 9 16 3 8K – –

ADUC7034 20 32 4,096 9 16 2 8K – –

ADUC7036 20 96 6,144 9 16 2 8K – –

ADUC7039 20 64 4,096 5 16 3 1K – 0

ADUC7060 10 32 4,096 14 24 10 8K 14-разр. DAC, ШИМ –

ADUC7061 10 32 4,096 8 24 10 8K 14-разр. DAC, ШИМ –

ADUC7121 40 126 8,192 32 12 9 1M – 4

ADUC7122 40 126 8,192 32 12 13 1M – 4

ADUC7124 40 126 32 30 12 12 1M – 2

ADUC7126 40 126 32 40 12 16 1M ШИМ 4

ADUC7128 40 126 8,192 28 12 10 1M 10-разр. DAC, DDS, ШИМ –

ADUC7129 40 126 8,192 40 12 12 1M DDS –

Таблица 3. Аналоговые микроконтроллеры семейства ADuCM36x

Устройство

Производи- 
тельность  

ЦПУ,  
MIPS

Размер  
Flash- 

памяти,  
кбайт

Размер  
SRAM,  
кбайт

Кол-во  
линий  
GPIO

Разре- 
шение  
АЦП,  
бит

Кол-во  
аппаратных  
узлов АЦП

Скорость  
преобра- 
зований  

АЦП, KSPS

Кол-во  
каналов  

АЦП 
Прочее

Кол-во  
выходов  

12-разряд- 
ного ЦАП

ADUCM360 20 128 8 19 24 2 3,906 11 ШИМ 1

ADUCM361 20 128 8 19 24 1 3,906 11 ШИМ 1
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в составе стартового комплекта можно использовать узкоспециали-
зированную плату EVAL-CN0300‑EB1Z Board, которая представляет 
собой готовый интеллектуальный датчик — монитор контроллера 
температуры с интерфейсом термопары и поддержкой промыш-
ленного интерфейса «токовая петля 4–20 мА». Для проектирования 
прецизионного датчика с возможностью питания от «токовой петли 
4–20 мА» передачи данных через HART-протокол можно воспользо-
ваться оценочным комплектом DEMO-AD5700D2Z. Он представляет 
собой физическую реализацию схемы CN0267 из раздела “Circuits 
From The Lab” сайта Analog Devices [7]. В состав DEMO-AD5700D2Z 
входят микроконтроллер ADuCM360, выполняющий задачи ввода 
сигнала с датчика и его первичной обработки, 16‑разрядный ЦАП 
с токовым выходом AD5421 и HART-модем AD5700.

Другая узкоспециализированная плата EVAL-ADuCM360TCZ Board 
также представляет собой готовый интеллектуальный датчик — мо-
нитор контроллера температуры с интерфейсом термопары и встро-
енным преобразователем интерфейсов UART-USB, через который 
она и подключается к ПК.

Программная поддержка МК семейства ADuCM36x (и USB-JTAG 
программатора J‑Link Lite) реализована в интегрированных средах 
разработки/отладки (IDE) μVision4 (V4.51) от Keil и IAR Embedded 
Workbench (V6.402) от IAR.

Описание макета измерителя

Для практического исследования МК ADuCM360 на предмет оцен-
ки возможности его применения в измерительных приборах, а также 
отладки измерительных алгоритмов авторы изготовили макет базо-
вого измерителя, внешний вид которого показан на рис. 3, а струк-
турная схема — на рис. 4.

В качестве пользовательских интерфейсов в макете использованы 
кнопки управления (для ввода команд пользователя), символьный 
4‑строчный ЖКИ, два индикаторных светодиода (для отображения 
информации о результатах преобразований, режимах и состояниях 
измерителя) и стандартный интерфейс RS‑232, реализованный с по-
мощью микросхемы — преобразователя уровней MAX3223 (DD2), 
подключенной к порту UART МК. Этот же интерфейс используется 
для внутрисхемного программирования встроенной Flash-памяти 
МК через ПК, о чем будет подробнее рассказано ниже. Отрицательное 
относительно общего провода напряжение, вырабатываемое микро-
схемой DD2, помимо прямого назначения — формирования сигна-
лов интерфейса RS‑232, поступает также через R12 на ЖКИ HG1 для 

Рис. 1. Структурная схема МК ADuCM360

Рис. 2. Стартовый комплект EVAL-ADUCM360QSPZ
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повышения контрастности его изображения. 
Необходимый уровень контрастности уста-
навливается подстроечным резистором R12, 
а необходимый уровень подсветки ЖКИ — 
подбором сопротивления R13.

Макет содержит стандартный разъем, 
предназначенный для подключения средств 
программирования/отладки из комплек-
та EVAL-ADUCM360QSPZ. Помимо интер-
фейсных цепей, к МК подключен внешний 
источник опорного напряжения — микро-
схема прецизионного ИОН AD780AN (DA3), 
имеющего температурную стабильность 
7 ppm/°C. Выбор значения выходного на-
пряжения DA3 осуществляется с помощью 
перемычки на разъеме X2: при установлен-
ной перемычке выходное напряжение ИОН 
равно 3,0 В, при снятой — 2,5 В.

Светодиоды подключены к выходам МК 
через транзисторные ключи, поскольку низ-
кая нагрузочная способность линий GPIO 
(максимальный ток нагрузки равен 1 мА) 
не позволяет подключать их непосредствен-
но. Питание макета осуществляется от внеш-
него источника постоянного напряжения 
+9–12 В, подключаемого ко входу первич-
ного стабилизатора DA1 напряжения +6 В. 
Напряжение от внешнего источника должно 
иметь уровень пульсаций, не превышающий 
нескольких милливольт. Дополнительную 
фильтрацию помех по питанию обеспечи-
вает НЧ-фильтр C1, L1, C2, C3. Катушка L1 
представляет собой ферритовое кольцо, об-
мотанное несколькими витками одножиль-
ного медного провода (мы взяли его из ста-
рой материнской платы ПК).

Напряжение с выхода DA1 используется 
для питания ИОН DA3, а также поступает 
на вход вторичного стабилизатора напря-
жения DA2, напряжение +3,3 В с выхода ко-
торого необходимо для питания цифровой 
части МК (напряжение DVDD). Для получе-
ния напряжения питания аналоговой части 
МК (AVDD) напряжение с выхода DA2 до-
полнительно пропускается через НЧ-фильтр 
L3, R3, C8, C9. Катушка L3 представляет со-
бой проводник, продетый сквозь феррито-
вую бусинку или кольцо. Аналогичный НЧ-
фильтр используется для подачи питания 
на микросхему ИОН DA3.

В документации производителя на ми-
кроконвертеры подчеркивается, что при 
разработке практических конструкций 
с их использованием для достижения мак-
симального возможного разрешения ана-
лого-цифровых преобразований необхо-
димо, как и в случае применения любого 
другого высокоточного АЦП, корректно 
выполнить заземление в системе и пра-
вильно выбрать топологию печатной пла-
ты. В предлагаемом макете реализован 
один из нескольких возможных подходов 
к топологии и заземлению, рекомендуемых 
производителем.

Цифровые компоненты устройства сгруп-
пированы на плате макета отдельно от ана-
логовых. Они расположены на разных ча-
стях платы таким образом, чтобы цифровые 
«земляные» (возвратные) токи не проте-
кали вблизи аналоговых «земляных» то-
ков. Сам МК размещен посередине между 
цифровой и аналоговой областями платы. 
Единственная шина заземления выполнена 
в виде сплошного проводящего слоя фоль-
ги. На принципиальной схеме этой шине 
соответствует точка соединения аналоговой 
и цифровой «земли» (точка GND на схеме, 
приведенной на рис. 5). С этой шиной мак-
симально короткими и толстыми проводни-
ками соединены общие провода всех стаби-
лизаторов напряжения в схеме. Заметим, что 
сама микросхема ADUCM360 имеет ножку 
только аналоговой «земли» AGND (вывод 
16 DD1), а роль ножки цифровой «земли» 
(DGND) у МК выполняет металлическая 
основа подложки кристалла, которая в схе-
ме на рис. 5 обозначена как PADDLE (вывод 
49 DD1).

Подключения цепей МК в схеме к «земля-
ной» шине выполнены проводниками воз-
можно большого сечения и наименьшей 
длины. Это же относится и к проводникам, 
соединяющим выходы ИОН DA3 с входами 
подключения внешнего ИОН МК VREF+, 
VREF– (выводы 14, 15 DD1). В качестве ли-
ний подачи входного измеряемого напря-
жения в схеме выбраны аналоговые входы 
AIN0, AIN1 (выводы 8, 9 DD1), снабженные 
внешними фильтрующими RC-цепочками 
(R4, C13, R5, C14). Эти входы сконфигури-
рованы в управляющей программе МК как 
дифференциальная пара.

Рис. 3. Макет измерителя напряжения на базе ADuCM360

Рис. 4. Структурная схема измерителя напряжения
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Описание программы  
для измерителя

Для исследования характеристик главно-
го узла МК — модуля ∆Σ-АЦП — была на-
писана несложная управляющая программа, 
реализующая функции измерителя посто-
янного напряжения. Исходный текст этой 
программы содержится в проекте adc_aducm, 
подготовленном в среде μVision4 V4.51. 
Архив проекта доступен для скачивания 
на сайте компании «ЭЛТЕХ» (www.eltech.
spb.ru). Алгоритм работы программы при-
веден на рис. 6.

В качестве основы был использован про-
ект adc из доступного на сайте производите-
ля МК набора примеров для ADuCM360/1. 
Программа позволяет осуществлять цикли-
ческие преобразования (измерения входного 
напряжения) и все виды калибровок для мо-
дуля ADC1 МК в выбранном входном канале 
(AIN1–AIN0), в выбранном диапазоне уси-
ления входных измеряемых сигналов (PGA 
GAIN = 1, то есть в диапазоне от 0 до напря-
жения используемого ИОН), в режиме пред-

ставления результата (биполярном) и при 
частоте обновления выходных данных АЦП 
(3,75 Гц). Есть также возможность выбора 
«на лету» в качестве ИОН для АЦП: встро-
енного ИОН МК (1,2 В), внешнего ИОН 
DA3 (3 В) или источника напряжения пита-
ния аналоговой части МК AVDD (3,3 В). Все 
приведенные параметры настройки АЦП 
можно изменить путем редактирования 
в программе функции инициализации АЦП 
ADC1INIT().

Результат каждого преобразования инди-
цируется на ЖКИ в десятичном представле-
нии со знаком полярности в двух различных 
форматах: в вольтах (с десятичными раз-
рядами после запятой) и в разрядах АЦП. 
Заметим, что биполярный режим представ-
ления результата не означает, что АЦП мо-
жет измерять напряжения, отрицательные 
относительно общего провода AGND. Это 
просто означает, что напряжение на одном 
из входов дифференциальной пары может 
быть как больше, так и меньше напряжения 
на другом входе на величину, не превышаю-
щую абсолютного значения опорного напря-

жения VREF. При этом напряжение на каждом 
из входов не должно выходить за пределы аб-
солютного диапазона входных напряжений 
АЦП (от AGND до AVDD).

Обновление показаний ЖКИ производит-
ся после каждого преобразования АЦП с за-
данным в программе интервалом между от-
дельными преобразованиями, равным 0,5 с. 
Синхронизация ядра и всех остальных узлов 
МК в программе задана от внутреннего ге-
нератора МК с частотой 16 МГц. Процедуры 
аналого-цифрового преобразования и выво-
да информации на ЖКИ и светодиоды в про-
грамме разнесены по времени, с тем чтобы 
перепады цифровых сигналов на линиях 
подключения ЖКИ и светодиодов не ухуд-
шали реальное разрешение АЦП, ограничен-
ное шумами.

Запуск преобразования АЦП осуществля-
ется в обработчике периодических преры-
ваний от одного из таймеров МК (TIMER0). 
При запуске каждого рабочего (некалибро-
вочного) преобразования загорается свето-
диод HL2, а при завершении преобразования 
он гаснет. При запуске любой калибровки за-

Рис. 5. Принципиальная схема измерителя напряжения
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горается светодиод HL3, а при ее завершении 
он гаснет. По готовности результата преоб-
разования в программе генерируется пре-

рывание от АЦП, в обработчике которого 
устанавливается программный флаг готов-
ности результата, опрос которого, обработка 

и вывод полученных данных на ЖКИ осу-
ществляются в главном цикле основной про-
граммы.

При работе программа опрашивает состо-
яние пяти кнопок. Их опрос производится 
в обработчике периодических прерываний 
от системного таймера МК (SysTick), входя-
щего в состав процессорного ядра Cortex-M3. 
Запуск калибровок осуществляется из глав-
ного цикла основной программы. Во время 
калибровок рабочие преобразования не про-
водятся.

При нажатии на  кнопку SB2 «Выбор 
ИОН» можно выбрать используемый ИОН 
по кольцу из приведенного выше перечня. 
При этом в правой части нижней строки 
ЖКИ отображается аббревиатура текущего 
выбранного ИОН: «INT», «EXT» или «AVD». 
При нажатии на кнопку SB3 «OFFS_I» про-
изводится внутренняя калибровка «нуля» 
(internal zero-scale), при этом в левой части 
нижней строки ЖКИ отображается над-
пись «OFFS_I». При нажатии на кнопку SB5 
«GAIN_I» производится внутренняя кали-
бровка верхнего предела шкалы (internal 
full-scale) с отображением на ЖКИ одно-
именной надписи. При нажатии на кнопку 
SB4 «OFFS_S» осуществляется системная 
калибровка «нуля» (system zero-scale) с ото-
бражением на ЖКИ одноименной надписи. 
Заметим, что перед проведением системной 
калибровки «нуля» на входы выбранного 
канала АЦП необходимо «вручную» подать 
системное напряжение «нуля», то есть по-
просту закоротить их между собой. При на-
жатии на кнопку SB6 «GAIN_S» производит-
ся системная калибровка верхнего предела 
(system full-scale) с отображением на ЖКИ 
одноименной надписи. Заметим, что перед 
проведением системной калибровки верх-
него предела на входы выбранного канала 
необходимо «вручную» подать системное на-
пряжение верхнего предела, то есть напряже-
ние выбранного в качестве ИОН источника. 
Напряжения ИОН могут быть сняты в схе-
ме с соответствующих разъемов: X7 «INT», 
X5 «EXT» или X4 «AVDD».

В  п о л ь з о в а т е л ь с ко м  р у ко в од с т в е 
по ADuCM360/1 [6] сказано, что при про-
ведении внутренних калибровок «нуля» 
и верхнего предела на выбранные входы 
АЦП внутри МК автоматически подаются 
нулевое напряжение и напряжение верхнего 
предела соответственно. Однако на практи-
ке оказалось, что у используемого авторами 
экземпляра ADuCM360 внутренняя кали-
бровка «нуля» производилась нормально, 
а вот запуск внутренней калибровки верх-
него предела фактически приводил к запу-
ску системной калибровки верхнего предела. 
То есть микросхема почему-то использова-
ла в качестве верхнего предела внешнее на-
пряжение, присутствующее на выбранных 
входах АЦП в момент запуска калибровки. 
Попытки добиться «штатного» проведения 
этой калибровки без участия внешнего на-

Рис. 6. Алгоритм работы программы
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пряжения путем варьирования режимов 
и настроек АЦП результата не дали. В доку-
ментации, касающейся ошибок и аномалий 
ADuCM360/1, представленной на сайте про-
изводителя, упоминания указанной ситуа-
ции найти не удалось.

После сброса МК в двух верхних строках 
ЖКИ начинают отображаться два десятич-
ных числа, каждое из которых будет соответ-
ствовать входному измеряемому напряже-
нию, представленному в вольтах и разрядах 
АЦП соответственно. При этом младшие 
несколько разрядов обоих чисел будут хао-
тически меняться от преобразования к пре-
образованию, ограничивая, таким образом, 
реальное разрешение АЦП шумами.

Закоротим между собой внешние концы 
проводников, подключенных к выбранным 
входам АЦП AIN0 и AIN1. Если считать, что 
меняющиеся младшие разряды отражают 
влияние собственных шумов АЦП, то чис-
ло неизменных нулевых старших разря-
дов как раз и будет отражать реальное раз-
решение данного АЦП. Другими словами, 
АЦП интерпретирует внешнее короткое 
замыкание своих дифференциальных вхо-
дов как нулевое входное напряжение с точ-
ностью до нескольких младших разрядов. 
Отображаемые на ЖКИ значения дают воз-
можность количественно оценить результа-
ты проведения всех доступных калибровок. 
В исследуемом макете до проведения кали-
бровок величина диапазона шумовых флюк-
туаций составляла прядка 300 мкВ.

Нажмем на кнопку «OFFS_I», запустив 
внутреннюю калибровку «нуля». На время 
проведения калибровки программа прекра-
щает преобразования, а после ее окончания 
запускает их вновь. После завершения этой 
калибровки отображаемый на ЖКИ результат 
остается практически неизменным, посколь-
ку эта калибровка не компенсирует влияние 
на результат внешних входных цепей АЦП, 
вносящих основную составляющую в шум. 
При нулевых старших разрядах хаотически 
меняются три младших разряда значения 
напряжения в вольтах (единицы, десятки 
и сотни микровольт) и пять младших разря-
дов значения результата АЦП в битах.

Теперь нажмем на кнопку «OFFS_S», запу-
стив системную калибровку «нуля». После ее 
завершения в значении результата будут ха-
отически меняться только разряды, соответ-
ствующие единицам и десяткам микровольт, 
то есть реальное разрешение АЦП теперь со-
ставляет порядка десятков мкВ.

Проведем системную калибровку верхнего 
предела шкалы. Для этого разомкнем пере-
мычку между входами АЦП и подключим 
отрицательный дифференциальный вход 
AIN0 к аналоговой «земле» AGND, а по-
ложительный AIN1 — к разъему X7 «INT» 
(1,2 В). На ЖКИ отобразятся результаты, 
близкие к 1,200000 В и к 268 435 456 разрядам 
(268 435 456 = 228 — верхний предел шкалы 
АЦП). После нажатия на кнопку «GAIN_S» 

отображаемые результаты максимально при-
близятся к указанным значениям.

После проведения перечисленных кали-
бровок можно окончательно оценить реаль-
ное разрешение АЦП. Для этого снова зако-
ротим между собой проводники на входах 
AIN0 и AIN1. Результат мало отличается 
от указанного выше, поскольку проведение 
системной калибровки верхнего предела 
изменяет абсолютное значение результа-
та (приводит его к выбранным пределам), 
но не улучшает реального разрешения.

Практика работы с макетом показала, что 
зачастую две-три системные калибровки 
«нуля», проведенные подряд с интервалами 
в несколько секунд, в итоге дают лучший ре-
зультат, чем однократная калибровка. Кроме 
того, в ходе экспериментов было установле-
но очевидное влияние на результаты кали-
бровки «нуля» температуры окружающей 
среды. Так, при температуре +26 °C после 
проведения системной калибровки «нуля» 
величина диапазона шумовых флюктуа-
ций (отличие показаний напряжения ЖКИ 
от нуля) составляла порядка 150 мкВ, а при 
температуре +32 °C — порядка 30 мкВ.

Выбор в качестве источника опорного на-
пряжения внешнего прецизионного ИОН 
AD780AN дает примерно такое же значение 
реального разрешения АЦП, как и для вну-
треннего ИОН: порядка десятков мкВ при 
наличии аналогичной температурной зави-
симости. Заметим, что полученные резуль-
таты существенно хуже заявленного произ-
водителем для этого диапазона измерений 
значения разрешения, равного 1 мкВ [6]. Это 
несоответствие, очевидно, можно объяснить 
отсутствием экранировки входов АЦП и це-
пей подачи внешнего опорного напряжения. 
Возможно, результат был бы лучше при на-
личии экранировки всей схемы.

Абсолютные значения результатов, полу-
ченные при измерениях одного и того же 
ненулевого напряжения с использованием 
разных ИОН, будут несколько отличаться 
друг от друга. Это объясняется тем, что опор-
ные напряжения в программе принимаются 
равными строго 1,2, 3,0 и 3,3 В, а на самом 
деле они могут отличаться от указанных зна-
чений в пределах допустимых отклонений, 
заявленных в документации на соответству-
ющие микросхемы. Например, для встроен-
ного ИОН ADuCM360/1 этот допуск состав-
ляет ±0,1% [4], для ИОН AD780AN — ±0,2% 
при напряжении 2,5 В и ±0,16% при напря-
жении 3,0 В. Чтобы устранить это расхож-
дение, необходимо эталонным вольтметром 
с разрешением не менее пяти десятичных 
разрядов после запятой на пределе «едини-
цы вольт» и погрешностью на этом пределе 
не хуже двух-трех единиц младшего разряда 
измерить указанные напряжения и получен-
ные значения в вольтах поместить в констан-
ты U_INT, U_EXT и U_AVDD, находящиеся 
в заголовочном файле adc_aducm. h. В край-
нем случае при коррекции констант мож-

но обойтись и без измерения напряжений, 
а просто привести измерения со всеми ИОН 
к единому результату по одному из них (с са-
мым маленьким допуском).

Для этого следует использовать формулу, 
по которой программа вычисляет входное 
измеряемое напряжение:

Vизм = (VREF)/228)ADC_DAT,

где Vизм — входное измеряемое напряже-
ние в вольтах. Оно отображается в первой 
строке ЖКИ. ADC_DAT — результат АЦП 
в битах, возвращаемый при программном 
чтении регистра результата АЦП ADC1DAT. 
Он отображается во второй строке ЖКИ. 
VREF — значение выбранного опорного на-
пряжения в вольтах. В программе оно содер-
жится в константах типа float: U_INT=1.2, 
U_EXT=3.0, U_AVDD=3.3.

Выявленный выше дефект АЦП, заклю-
чающийся в невозможности корректного 
проведения внутренней калибровки верх-
него предела, существенно осложняет поль-
зовательскую калибровку измерителя. Если 
в конечном устройстве к измерительному 
каналу АЦП постоянно подключен какой-то 
внешний датчик, то после каждого включе-
ния питания пользователю придется вруч-
ную отключать его, коммутировать на вход 
канала напряжение верхнего предела, про-
водить системную калибровку, а затем снова 
подключать датчик. Одно из возможных ре-
шений этой проблемы состоит в следующем.

Системные калибровки «нуля» и верхне-
го предела можно произвести однократно 
в начале эксплуатации измерителя, а после 
их проведения содержимое калибровочных 
регистров АЦП по команде пользователя со-
хранить во Flash-памяти МК. При последую-
щих включениях питания устройства содер-
жимое соответствующих ячеек Flash-памяти 
автоматически или по команде пользователя 
может быть загружено в соответствующие 
калибровочные регистры АЦП. Заметим так-
же, что калибровки (и запись во Flash-память 
полученных в результате значений) можно 
произвести при оптимальной (с точки зре-
ния минимизации величины диапазона шу-
мовых флюктуаций) температуре.

Массив Flash-памяти МК ADuCM360/1 раз-
мером 128 К организован как 32 блока. 
Каждый блок содержит восемь страниц, 
а каждая страница имеет размер 512 байтов. 
Содержимое Flash-памяти МК доступно для 
непосредственной записи из пользователь-
ской программы со следующими ограниче-
ниями:
•	 Поддерживается запись только 32‑разряд-

ных значений.
•	 Перед записью содержимое Flash-памяти 

должно быть стерто, причем поддержива-
ются только постраничное стирание или 
стирание всего массива памяти.

•	 Ресурс количества циклов стирания/записи 
составляет минимум 10 000 циклов [4].
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Исходный текст управляющей программы, 
реализующей измеритель напряжения с воз-
можностью сохранения калибровок во Flash-
памяти МК, содержится в  проекте adc_
aducm_f, архив которого доступен для скачи-
вания на сайте «ЭЛТЕХ» (www.eltech.spb.ru). 
Параметры и пользовательский интерфейс 
этого измерителя аналогичны предыдущему, 
но в качестве ИОН для АЦП программа ис-
пользует только внешний ИОН DA3 (3 В). 
Кроме того, интерфейс не поддерживает воз-
можность проведения внутренних калибро-
вок АЦП. Для запуска системных калибро-
вок «нуля» и верхнего предела, как и в пре-
дыдущем случае, используются кнопки SB4 
«OFFS_S» и SB6 «GAIN_S». Эти калибровки 
достаточно произвести однократно в начале 
эксплуатации устройства.

При нажатии на  кнопку SB2  текущее 
содержимое калибровочных регистров 
АЦП «нуля» (ADC1OF) и верхнего преде-
ла (ADC1EXTGN) записывается во Flash-
память на страницу с адресом 0x1FC00. 
Предварительно программа производит 
стирание этой страницы, используя функ-
ции работы с Flash-памятью из библиотеки 
FlashEraseWrite. c. Процесс стирания/записи 
Flash-памяти индицируется на ЖКИ надпи-
сью «SAVE_K», а его завершение — надписью 
«__OK__». При нажатии на кнопку SB3 со-
храненные ранее во Flash-памяти калибро-
вочные значения копируются в калибровоч-
ные регистры ADC1OF и ADC1EXTGN, что 
сопровождается последовательным выводом 
на ЖКИ надписей «LOAD_K» и «__OK__».

Работа с программной средой 
μVision4 V4.51

Немного о разработке приложений для 
МК ADuCM360/1 в среде μVision4 V4.51. 
Разработка приложения начинается с созда-
ния нового проекта. В меню главного окна 
IDE µVision4 следует выбрать Project → New 
µVision Project…, затем в открывшемся 
стандартном диалоговом окне дерева фай-
лов и каталогов выбрать Create New Project. 
Рекомендуется размещать все файлы каж-
дого проекта в отдельной папке. После соз-
дания папки проекта и задания его имени 
µVision4 создаст новый файл проекта с этим 
именем и расширением .uvproj, который со-
держит сведения о заданной по умолчанию 
целевой системе, а также заданные по умол-
чанию имена групп файлов.

Следующий шаг — это выбор из базы под-
держиваемых IDE µVision4 устройств требуе-
мого МК. Когда IDE описанным выше образом 
создает новый проект, то вслед за созданием 
проектного файла сразу же автоматически от-
крывается диалоговое окно Select Device for 
Target, показанное на рис. 7. Это окно отобра-
жает базу поддерживаемых µVision4 устройств. 
В нашем случае выбираем ADuCM360.

Следующим шагом является добавление 
к созданному проекту так называемого кода 

запуска выбранного ранее МК. Для любой 
встроенной программы всегда необходимо 
наличие некоторого кода начальной низ-
коуровневой инициализации МК, который 
должен соответствовать требованиям, зада-
ваемым в приложении. Помимо инициали-
зации МК целевой системы, код запуска вы-
полняет также инициализацию некоторых 
параметров компилятора IDE µVision4. Для 
удобства модификации кода запуска при ра-
боте с проектом его рекомендуется хранить 
в отдельном файле. В общем случае разра-
ботчик может написать код запуска вруч-
ную, как и остальной пользовательский код. 
Однако для облегчения написания встроен-
ных программ IDE µVision4 при создании 
проектов предлагает пользователю скопи-
ровать в его новый проект уже готовый код 
запуска, соответствующий данному МК.

Диалоговое окно предложения копирова-
ния готового кода запуска в новый проект 
показано на рис. 8. Рекомендуется ответить 
на вопрос µVision4 щелчком на кнопке Дa, 
после чего к проекту будет автоматически 
добавлена папка с именем по умолчанию 
Source Group1, содержащая файл с готовым 
кодом запуска, имеющий по умолчанию имя 
startup_ADuCM360.s.

Следующий шаг разработки прило-
жения — создание файла (файлов) с ис-
ходным текстом встроенной программы. 
Пользователь может создать новый исход-
ный файл, выбрав в меню File → New… 
После этого откроется пустое окно редакто-
ра, в котором можно набрать исходный текст 
вручную или скопировать его из буфера. 
Когда пользователь сохраняет созданный 
файл с помощью диалогового окна File → 
Save as… как файл с расширениями .c, .h, 
IDE µVision4 осуществляет цветовое подсве-
чивание синтаксиса кода на языке C.

Как только пользователь создал файл с ис-
ходным текстом, он может добавить этот 
файл к своему проекту. IDE µVision4 пред-
лагает несколько способов такого добавле-

ния. Например, можно выбрать курсором 
позицию табуляции всего проекта (верхне-
го уровня проекта) в окне Project, а затем 
щелчком правой кнопки мыши открыть для 
этой группы контекстное меню, как показано 
на рис. 9. Затем выбрать в меню опцию Add 
Group…, после чего в проекте будет созда-
на новая группа, которой можно дать какое-
то имя. Если выбрать курсором позицию 
табуляции этой группы и щелчком правой 
кнопки открыть для этой группы контекст-
ное меню, то в нем будет доступна опция 
Add Files to Group…, при выборе которой 

Рис. 7. Диалоговое окно выбора МК целевой системы Select Device for Target

Рис. 8. Предложение копирования готового кода 
запуска в отдельный файл нового проекта

Рис. 9. Контекстное меню для уровня проекта
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откроется стандартное диалоговое окно фай-
лов и каталогов. Если выбрать в этом окне 
нужный файл и щелкнуть на кнопке Add, 
то в результате этот файл будет включен 
в состав проекта и его позиция табуляции по-
явится в окне Project ниже позиции уровня 
проекта. Если дважды щелкнуть на имени 
этого файла в окне Project, то он откроется 
для просмотра и редактирования на страни-
це Text Editor стандартного окна редактора. 
В итоге все созданные и включенные в состав 
проекта группы и файлы отобразятся в окне 
Project, как показано на рис. 10.

Входящие в проект файлы пользователь 
может объединять в группы и помещать 
их в  разные папки и  другим способом. 
Выбор в меню опции Project → Manage → 
Components, Environment, Books… при-
ведет к открытию страницы компонентов 
проекта Project Components диалогового 
окна Components, Environment and Books. 
С помощью средств этой страницы пользо-
ватель может создавать, удалять или перено-
сить объекты и таким образом группировать 
файлы в папки в соответствии с логикой их 
содержимого. Это рекомендуемая практика 
построения проекта, повышающая степень 
его структурированности и облегчающая 
ориентацию в нем разработчика.

В составе одного проекта в IDE µVision4 
могут быть заданы несколько различных це-
левых систем, например целевая система для 
симуляции выполнения пользовательского 
кода в ПК и целевая система для записи кода 
во Flash-память МК. При этом опции для 
каждой из них можно задавать независимо. 
Для добавления в проект новых целевых си-
стем в дополнение к заданной по умолчанию 

(Target 1) используется окно Components, 
Environment and Books…

Диалоговое окно задания опций целевой 
системы Options for Target открывается с по-
мощью соответствующего значка на панели 
инструментов IDE µVision4 или путем вы-
бора в меню Project → Options for Target. 
Это окно имеет несколько страниц, каждая 
из которых содержит специфический набор 
настроек, например параметры компилято-
ра C/C++ (C/C++), компоновщика (Linker), 
отладчика (Debug), перечень генерируемых 
в проекте выходных файлов (Output) и т. д. 
В рассмотренных выше проектах все необхо-
димые опции целевой системы уже заданы.

После этого можно перейти к формиро-
ванию проекта, под которым понимается 
процесс компиляции его исходных фай-
лов, а также их последующей компоновки 
(линковки). Процесс запускается нажатием 
на кнопку Build панели инструментов или 
выбором в меню Project → Build Target. 
В ходе формирования проекта µVision4 ото-
бражает ошибки, предупреждения и любые 
другие сообщения в окне Build Output. Если 
дважды щелкнуть на сообщении об ошибке, 
то в окне редактора откроется соответствую-
щий исходный файл, а курсор будет указы-
вать местонахождение в нем ошибочной или 
некорректной строки. В случае безошибоч-
ного формирования проекта IDE µVision4 со-
общит об успешном завершении формиро-
вания, как показано на рис. 11.

После формирования проекта разработ-
чик может изменить существующий исход-
ный текст или добавить новые исходные 
файлы к проекту, а затем повторно сформи-
ровать проект. Если при этом использовать 
кнопку Build или опцию меню Project → 
Build Target, то повторно откомпилированы 

и скомпонованы будут только измененные 
или новые исходные файлы. При исполь-
зовании кнопки Rebuild или опции меню 
Project → Rebuild all target files будут отком-
пилированы и скомпонованы заново все ис-
ходные файлы, независимо от наличия мо-
дификаций.

Как уже упоминалось, программирование 
встроенной Flash-памяти ADuCM360/1 может 
быть осуществлено двумя способами: с по-
мощью USB-JTAG-программатора и через 
порт UART МК, снабженный внешней микро-
схемой — формирователем уровней RS‑232. 
Второй способ обеспечивает минимальные 
затраты аппаратных средств. Программная 
поддержка этого способа реализована про-
изводителем МК с помощью компьютерной 
программы-загрузчика CM3WSD, которую 
можно бесплатно загрузить по ссылке со стра-
ницы [7]. Загрузчик позволяет производить 
стирание всего массива Flash-памяти МК, ее 
простое программирование, программирова-
ние с верификацией (сравнением) и просто 
верификацию содержимого памяти с содер-
жимым заданного в программе файла «про-
шивки». Программа поддерживает только 
один формат файлов прошивки — с расши-
рением .hex. Заметим, что для генерации вы-
ходного hex-файла при формировании про-
екта в IDE µVision4 необходимо на странице 
Output окна задания опций целевой системы 
Options for Target отметить галочкой опцию 
Create HEX File.

Скорость обмена с  МК в  программе 
CM3WSD может быть выбрана пользовате-
лем из стандартного ряда. Пользовательского 
задания скорости обмена модуля UART МК 
при этом не требуется, так как он автомати-
чески конфигурируется в ходе выполнения 
протокола последовательной загрузки.

Рис. 10. Все созданные и включенные в состав проекта 
группы и файлы

Рис. 11. Результат безошибочного формирования проекта
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Загрузка прошивки приложения в МК осуществляется в следу-
ющем порядке. Устройство с МК подключается через интерфейс 
RS‑232 к COM-порту ПК прямым (не нульмодемным) кабелем, 
а в окне запущенной программы CM3WSD необходимо указать: но-
мер используемого COM-порта ПК, путь к hex-файлу прошивки, 
скорость обмена и требуемую операцию с Flash-памятью МК. Затем 
нужно однократно щелкнуть на кнопке Start программы, после чего 
она будет ожидать перевода МК в режим последовательной загрузки. 
Перевод МК в этот режим производится в момент включения его пи-
тания или генерации внешнего сброса при внешнем низком уровне 
на линии порта P2.2. В нашем макете для перехода в режим последо-
вательной загрузки следует нажать на кнопку SB1 «Сброс», удерживая 
при этом в нажатом состоянии кнопку SB4. При переходе в режим 
последовательной загрузки инициируется резидентная подпрограм-
ма загрузчика, размещенная в области Flash-памяти МК kernel space, 
которая и выполняет требуемую операцию с памятью. Процесс запи-
си/верификации индицируется нарастающей шкалой в нижней части 
окна программы CM3WSD, как показано на рис. 12.

Примечательно, что при записи пользовательского кода во Flash-
память МК с помощью операций программы CM3WSD Program, 
Program and Verify загрузчик производит предварительное стирание 
не всего массива памяти, а только необходимого количества ее стра-
ниц от начала адресного пространства (адрес 0x0000). Так, при записи 
кода проекта adc_aducm_f размером 8908 байтов стирается только 
18 страниц (9216 байтов). Таким образом, содержимое страницы 
с адресом 0x1FC00 в конце адресного пространства, где приложение 
хранит калибровочные значения, указанными операциями не затра-
гивается.

Работа с оценочным комплектом  
EVAL-ADUCM360QSPZ

Другим этапом работы стала оценка возможностей АЦП микро-
контроллера при использовании оценочного комплекта EVAL-
ADUCM360QSPZ.

Результаты, полученные ранее при исследовании самодельного ма-
кета, было решено сравнить с результатами измерений, проведенных 
с помощью оценочного комплекта, сделанного в фабричных услови-
ях. Для адаптации проекта adc_aducm на плате EVAL-ADUCM360MKZ 
ее пришлось несколько доработать: разомкнуть перемычки J6 и J7, 
а также изъять из схемы резисторы R5 и R4, чтобы освободить ис-
пользуемые программой каналы АЦП от посторонних внешних це-

пей. (Принципиальную схему платы EVAL-ADUCM360MKZ можно 
загрузить в виде архивного файла со страницы по ссылке [8].) После 
этой доработки входное положительное напряжение (канал AIN1) 
на плате подавалось на контакт REFIN+, а входное отрицательное (ка-
нал AIN0) — на контакт перемычки J6, к которому в схеме подключен 
резистор R8. С помощью имеющихся на плате разъемов к ней в со-
ответствии со схемой, показанной на рис. 4, были также подключены 
кнопки, ЖКИ с подстроечным резистором и преобразователь уров-
ней MAX3223 (последний — в качестве источника отрицательного 
напряжения для ЖКИ). Питание платы осуществлялось от первич-
ного стабилизатора DA1 от самодельного макета.

Эксперименты с платой EVAL-ADUCM360MKZ при использовании 
только встроенного ИОН МК (1,2 В) дали следующие результаты.

До проведения калибровок величина диапазона шумовых флюк-
туаций составляла порядка 40 мкВ. Объяснить это, вероятно, можно 
тем, что у платы EVAL-ADUCM360MKZ линейные размеры (и, сле-
довательно, диапазон шумовых флюктуаций) внешних цепей в ис-
пользуемых каналах АЦП значительно меньше, чем в самодельном 
макете.

Выявленный выше дефект АЦП, заключающийся в невозможно-
сти корректного проведения внутренней калибровки верхнего преде-
ла, здесь также был обнаружен.

Зависимость результатов калибровки «нуля» от температуры окру-
жающей среды также имела место, но была несколько слабее выраже-
на. Так, при температуре +26 °C после проведения системной кали-
бровки «нуля» величина диапазона шумовых флюктуаций составля-
ла порядка 25 мкВ, а при температуре +32 °C — порядка 18 мкВ.

Для адаптации проекта adc_aducm под загрузку/отладку сред-
ствами комплекта EVAL-ADUCM360QSPZ необходимо на странице 
отладчика Debug окна Options for Target проекта указать исполь-
зуемый программатор-отладчик (J‑LINK/J‑Trace Cortex), как пока-
зано на рис. 13, а затем подключить через USB-порт к ПК хоста USB-
JTAG-программатор J‑Link Lite и кликом на кнопке Settings стра-
ницы Debug открыть окно Cortex JLink/JTrace Target Driver Setup. 
При этом IDE μVision4 должна опознать подключенное устройство 
и на странице Debug указанного окна отобразить его уникальные па-
раметры: серийный номер, название, версии прошивок, как показано 
на рис. 14.

Доступные для пользовательской установки настройки на этой 
странице следует задать так, как показано на рис. 13. Затем необ-
ходимо перейти на страницу Flash Download (рис. 15) и в ее поле 
Programming Algorithm задать загрузчик Flash-памяти МК, выбрав 
его из списка, открывающегося при нажатии на кнопку Add.

На этой же странице можно задать или изменить заданный 
по умолчанию набор операций, производимых загрузчиком при об-

Рис. 12. Окно программы-загрузчика CM3WSD

Рис. 13. Страница Debug окна Options for Target
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ращении к Flash-памяти МК: стирание всего массива, стирание секто-
ров, программирование, верификацию и пр.

Загрузка файла прошивки, сгенерированного в результате успеш-
ного формирования проекта, во Flash-память МК с помощью 
программатора J‑Link Lite может быть осуществлена из главного 
меню IDE μVision4 путем использования кнопки Download на ин-
струментальной панели или опции меню Flash → Download.

Выводы

Авторы статьи постарались как можно подробнее описать все эта-
пы работы с микроконтроллером, начиная с выбора микросхемы 
в соответствии с решаемой задачей и заканчивая работой с настрой-
ками микроконтроллера для достижения наилучших результатов. 
Подробно описан процесс калибровки АЦП для различных вариан-
тов проведения измерения и выяснено, насколько соответствуют па-
раметры микросхемы, заявленные в технической документации про-
изводителем, тем, что получены на практике. Очевидно, что при ис-
пользовании платы, конструкция которой выполнена в соответствии 
с рекомендациями фирмы — производителя микросхемы (в нашем 
случае это был оценочный комплект), характеристики микросхемы 
соответствуют заявленным.

Мы надеемся, что материалы этой статьи пригодятся инженерам-
разработчикам при создании собственных устройств, позволят им 
уменьшить время работы по проекту, избежать ошибок при проек-
тировании и написании программ, а фирмам-производителям — вы-
вести их продукцию на рынок в более короткие сроки.

Выражаем благодарность компании «ЭЛТЕХ», предоставив-
шей оценочный комплект EVAL-ADuCM360QSPZ и микросхемы 
ADuCM360BCPZ128 для работы.

Авторы будут рады получить отзывы на этот материал по адре-
сам электронной почты, указанным в начале статьи.	  n
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